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BIOS / UEFI Utilities

rebuilding the firmware provide a clear advantage in reducing both time and cost.

AMI Firmware
Update (AFU)

AMI Firmware Update (AFU) is a scriptable
command line utility for DOS, Microsoft
Windows®, Linux, FreeBSD and the UEFI
shell. Utilized for factory or field BIOS
updates, AFU is flexible enough to update
the entire Flash part or only a portion. It
programs the main BIOS image, boot block
or OEM configurable ROM regions
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FEEDBACK AND INFORMATION

© ANY FEEDBACK YOU PROVIDE AT THIS SITE SHALL BE DEEMED TO BE NON-
CONFIDENTIAL. AMERICAN MEGATRENDS INC. IS FREE TO USE SUCH INFORMATION ON AN
UNRESTRICTED BASIS.
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New on our Tech Blog: Part 3 of A
Beginner's Guide to PC Building'

(¢ Blog Posts

Since 1985, American Megatrends
(AMI) has designed, created and
manufactured key hardware and
software solutions for the global
computer marketplace, providing
the highest quality and compatibility
necessary to build today's advanced
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File Rom GUID: Unknown
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Latest Overclocking Programs, System Info, Benchmarking, & Stabilty Tools

Here are some of the most popular benchmark softwares used to gauge computer performance.This site and its author wont be held responsible or iable for any lost or damages
resulting from the use of any programs included on this page. The use of any programs included on this page is at your own risks!

Stability Test

Prime9sv.29.4 Build 7 (32-bit)
Prime95v.29.4 Buid 8 (64-bit)
X264 HD Benchmark 5.01

occras.1
IntelBumTest v2.54-10.3.12 (original)
IntelBurnTest v2.54-11.0.0
IntelBurnTest v2.54-11.0.1

LinX 0.6.5

LinX 0,6.511.1.0

LinX 0,6.5-11.1.1

LinX 0.6.5-11.12

LnX 0651113

LinX 0651120

X 0.6511.2.1

LinX 0.65-11.22

LinX 0,6.5-11.3.0

LinX 0.6.6-11.3.2

LinX 0.6.6-2017.0.005

LinX 0.681133

LinX 0.6.9-2017.0

Lin 0.7.0-2017.1

LinX 0,

5P2004 Orthos

System stabilty Tester 151 (32-bi)

System stabilty Tester 151 (64-bi)
Fr23.1

HeawyLoad 3.3.1 (32-bit)

HeavyLoad 3.3.1 (64-bit)

Intel® Linpack 11.1.0.002

Intel@ Linpack 11.1.1.003

Intel@ Linpack 11.1.2.004

Intel® Linpack 11.13.005

Intel® Linpack 11.2.0.003
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AMI (UEFT) BIOS Tools

AMIBCP 4.55.0070
AMIBCP 5.01.0014
AMIBCP 5.02.0023
fTool Aptio 4.50.0°
MMTool Aptio 5.00.0007
MMTool Aptio 5.02.0024
MMTool Aptio 5.02.0024 Mod
UEFT BIOS Updater vL.6x.x
UEFITool 0.22.4

AMI Flash

FLASHEFI (P67/268)

Efiflash downgrade
Phoenix Mod Tool 2.19 (SLIC)
Phoenix Mod Tool 2.6 (SLIC)
SUC Toolkit v.3.2

AMI Change Logo 4.55

FPT-Win32/64- 207
FPT-Win32/64- X99
-D0S-
FPT-Win32/64- 2170
FPT-Win2/64- 2170/270
Intel@® System Tools v.8.1 (for Intel@® 7)
Intel@® System Tools v.9.0 (for Itel® 8)
Intel® System Tools v.9.1 (for Intel@® 9)
I system ol . o ns 100/200/200
FTK- Fiash ToolKit v0.11 (for Intel® 6/7)
FTK- Fiash Toolkit v0.10 (for Intel@® 8)
FD44Editor 0.9.1
287 B10S Backup

Useful Tools

WInRAR 5.60 Beta 3

‘SystemRescueCd 5.2.2
Vista Boot PRO 3.3,
EasyBCD 2.3
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Archive (.ZIP)

File size: 394.76 KB
Uploaded: 2012-04-13 10:39:20

About Compressed Archive Files
MMTool 4.50.0.23.zip
Compressed archives combine multiple flesintoasingle G
file to make them easier to transport or save on
diskspace. Archiving software may also provide options e
for encryption,
and selfinstall
d by the Wi

Broadband | 0.06s
st 1545
Mobile. 0285

spanning, checksums, self-extraction,
the most-widely used format,

uses the tar and gz format.
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TITIEE, 1IETRELEC RT7A4 7HE FD LetsNoteBI0OS &9 7 4 /L X DHID SX2BI0S_ORG. rom %
BIRLTHE £
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Insert | Replace | Delete | Extract | CPU Patch | RomHole
Save Image Module il | Browse
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Greate Report

For Option ROM only Insert FFS Options.
Close
[ Link Present e

Volume | Index | FileMame Source siee GUID ~

on on O003FFER GEFGBAA3-476D-407F-0FDC-E98 143E0422C

01 on O003FFER GEFGBAA3-476D-407F-0FDC-E98 143E0422C

02 on IntelSatiopDriver 000140#A SC26606S-E 105-4043-9AB5- 1207095BE2AF

12 11 DtellvbGopDriver 1000ACH 5EBABIEG-F027-4CAT-BF DI~ 16356000E 129

12 12 10004418 17098572-377F - 44EF-6F AE-BOGFFF46A070

12 13 Cpubxe 00001890 E0IABADF-E536-4E60-B3A0-ETTFTAERA,

12 04 FileSystem 00046CA 93020F 8- IF09-47EF-BBB2-58 14FF0IDFE

12 [ 10002974 DAG2B1 17-BEFB-4364-A%12-0DCCT7061B..

02 06 000283 §221316B-20BB-4EB5-813E- 1B1BF4712BD3

02 7 CORE_DXE 0022987 GAESF37E-4EAE-41AE-8240-354REBAERTER

02 ik:3 Runtime 0n00ABSE: GRCHICYA-283A-4 1EB-AREE-440BAEARRT

02 ik} ReFlash 000026238 FOE1AR18-0BE 1-4440-BF D4-0EFGRCFFOIAR

02 A PoiBus 00006150 BCIDE3AF-DA07-408A-AACC-FRICFBZFID

02 B AmiBoardinfo 00005AR3 OF3A0016-AERE-4288-829D-D22F D3 44247

02 s EBC 000 1B0A 13ACR0OD0-7300-1104-BOGB-00AAINBDED

[ 10 OpunitDxs 1000GESC: 620171087800 4450-678-COA2ATZABDE

12 IE  SmmRelocDxe 10000720 FFEDT2EE-0170-4814-0878-AOFE | B64DF AF

12 IF  SmmRelocPeim 10000564 ABETAFEI-F D2D-4072- 432 1-GAFGT20TTE,

12 10 SmmBaseRuntime 10001435 55526754 TED- 4D 1-A3AL-F 547351 B4SE

12 1 SmmDisc 10002E87 0CEEDTD-FEFF-431C-BG 14- 334 EAEAGL.. Y
[ MMTool Aptio- SK2BI0S_ORG.rom - X

Load Image Insert | Replace | Delete  Extract | pU patch | Romole |

Save Image Module il | Browse
Save Image as.
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Create Report
For Option ROM only Extract FFS Options
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[~ Link present

¥ Extract Asis

Volume | Index | FileMame Source size GUID ~
02 D8 000000F3 996AAIEQ- TESC-4F36-BE19-A170A206FC 14
02 D9 OemlLogDxe 00000EDF 80DB712E8-87F8-4BY1-8E84- 163F 078666 1F
02 oA 0nooB0IC 924 A1E90-4609-4D7 A-ACFB-CAAFGC1GE.
02 DB 0000066G AFBICATI-FFGB-4B40-876D-FFFEETGAB46D
02 oc UltraPOST 000016CY F82E6264-FDCA-4BI0-BE 18-856C6DAF 3G
5D0_Realtek Dxe 00000980 40E7ADGA-4BEC-4ANB-ABES-0C30NI82BE.
EC 00003B38 2CH0DACE-EY9B-4D46-A124-BB3AG IE4AT2
Eclpdate 000016C3 24311CA9-32C4-4804-8A0D-ERD3DGIF AZBE
OEMDE 0000082 1 BFE206CI-6B17-4FBF-9376-80614 AFBE 199
T N T S Vi ST
00001836 7BB28BII-61BB-11Da-0AKD-0030273FC 14D
0noondss 13F724D3-600C-42F0-9FEC-9DFE7DFGEGGY
0000033G 243DDBYE-3F02-4EFE-BD04-262EFN95 1980
000002A0 FF82BATC-088F-4G36-978C-9F 7ABOGYTF 1
00000200 8310F3E3-D300-4561-955A-BE48B 7774607
000003A0 A3SIGDIF-4GAA-4186-BY57-BEB2EDTTIEFY
000004 1F FCAOGF 12-916B-4DDC-AET7-ANBDBCFDAS
0000085G BEDAZ71E-7D4D-4130-BY77-GDDESS2DE5E
CsplibDxe 000000G3 GD84562C-6864-40A3-A081-CBD35ER2BI20

Memorvinit 0001F 186 JB42EF57-16D3-44CB-8632-9F DBOGE4 1451 ad
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@Extra As is (27 4= A% Ffo> T (2 THREBTHENIUE T 4 — B AR 7= FEIL
@Z DIREEND FRAZF 2 &5
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TN TEFHLIAALT BIOS £ A— D7 4V XT Setup. ffs & L THIH SN ET,
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ZZCIERTETHIE L7 (Setup. ffs] 77 A /LDOHIZH D BIOS A=a—FKRT7 T 7%, SLCC, T

5 OEF AL F YV —xF ¢ & [HxD] TT,

Zru—RE FRURLICT Z7®ALET,
https://mh—nexus. de/en/hxd/

Bl = oo e et x [
O e 8 mhnexusde e mx * 2 @
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HxD is a carefully designed and fast hex editor which, additionally to raw disk editing and modifying of main memory (RAM), handles files of any size.

2, checksums/digests, insertion of byte patterns, a file shredder, concatenation or

easy to use interface offers features such as searching and replacing, expor

splitting of files, statistics and much more.

Editing works like in a text editor with a focus on a simple and task-oriented operation, s such functions were streamlined to hide differences that are purely
technial

te rive and memory arepresented smiarto a il and areshown 3 3 hole, 1t contrast toa sectorregon imited view that uts of dats which
potentialy elongs together. Dives and memory i b edited th same way 25 & regtar s ncafing Support for . In addiion memory-sactions defne a
foldable region and inaccessible sections are hidden by default.

Furthermore a lot of effort was put into making operations fast and efficient, instead of forcing you to use specialized functions for technical reasons or arbitrarily
imiting file sizes. This includes a responsive interface and progress indicators for lengthy operations.

Features

B 2 O SR
« RAM-Eit

To adit the main memory

+ Memory sections are tagged with data-folds

* Dkt (Hard diks, floppy dsks, 2P.diks USH lachdrves,COs,

¥ reading and writing of disks and drive
 for Wi T and s

+ Instant opening regardless of file-size
Up to 8EB; opening and editing is very fast

ZOEEOHFRIESITIZH D MMTool Aptio 4.50.0023] MNA v — Rxf&RTY,

B = too- reovae vt x |10
O @ A hosmesde Dx| = 2 @

707 [ Google [l vahoo! [ vavews [ mum
+ Prnung
? Querwritoor st
 Cut, copy, pase insert, paste write
L Clount oot o thor e sdors
Visual Studio/Visual C=+, WinHex, HexWorkshop,

+ Bookm:
. eueShifsNumber (0.9)sets a bookmark
CtrieNumber (0-9) goes to a bookmark

+ Navigating to nibbles with Ctri+Left or Ctrl+Right
+ Flicker free display and fast drawing

2.1 (September 27, 2018) What's new?
Windows XP, 2003, Vista, 7, 8 or 10.

1.7.7.0 (April 3, 2009) Whats new?
Windows 95, 98, ME, NT 4, 2000, XP, 2003, Vista, or 7

bdoouniond pase

License

HaDi fre o charge for private and commercial use. Seling 1 s notallowed, istribuin t a3 partof magazine addon CDs / DVDs/athermedia o putting it on
download portals or private websites is allowed and welcome. For details, please see the HxD Li

What's new
Complete change log for HXD

Notes

Disk-Editor

To use the disk editor under Windows NT/2000/XP/2003/Vista/7 and higher you have to be an administrator o have the appropriate privileges.

Staring with Vista you need to manually umount thehard i tosuccessfly it 01, o nathr words: make sue th dsk you edit has o mounted fle

this forum thread. A system drive (the one where Windows is installed on) cannot ba written to while Windows s running. In order to still
e o el e S 158 et oAb YR AR o i e S g 5 W .

Windows NT 4

Windows FH® TDownload Page] #27 Vv 27 LT, Fvru— RK_X—=JIZBEILET,

10



RUE] = cowncassiminens < [N = ® =
« O @ | 6 Hos/mimeusse x| = L @
HE = 707 Google Yahoo! PEE2 BuE
P

Downloads

Note: Starting with HxD 2.0, the portable edi
only into the selected folder (e.g., USB thur

created once with the setup program, and then is independent. For the portable edition, the setup program writes

B2 Hx020, installable 21 MalHérz  September 27, Download per c72bab4ede219ebB0bCI44040e6514b79a19d81
G (can create 2018 Y s TS

portable) .
HxD20, installable 24 MaglHorz  September 27, Download per c72bab4ede219ebB0bCi44040e6514b79a19d81
English (can create 2018 e HLIES

portable) —
8 020, installable 21 Le September27, [ ]  Downloadper  c72babdede219ebB0bci44040ef6514b75a19d81
French (can create Ch@land 2018 % g HLLES

portable) AL
(22 Hxb20, installable 2.1 Jehwan  September27, Download per  c72bab4ede19eb30bcl44040ef6514b79a19d81
Korean (can create Yun 2018 28 g HITPS

portable) .

-3 v X

OV A S THLERWTT 2, German £ 721X English 720 NEWTL X 9,
Mownload per HITP] #27 U v/ LizF v mn—RLTLEEV,

7 7 Av41%,. THxDSetup. zip] T,
ThEERY —LVERIFIT s A 7a—F —TRERB LT EEN,

FE1T77 7 A4 /iL.  [HxDSetup. exe] T,

EIT 77 ANEE TN v I LA A =L LET,

Select Setup Language o

Select the language to use during the
installation:

English R

OK RHZ U ZLET,

[§5) Setup - HxD Hex Editor = %

Welcome to the HxD Hex Editor
Setup Wizard
This will install HxD Hex Editor 2.1 on your computer.

Itis recommended that you dose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

Next R Z U H L £9,

11



5! Setup - HxD Hex Editor

License Agreement

Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

HxD License 2
HxD Copyright® 2002-2018 by Maél Hérz. All rights reserved.

"Software” refers to HxD and all files belonging to the program, including
documentation.

\Warranty disclaimer o

L accept the agreemey

(O 1do not accept the agreement

I accept the agreent |ZF = v 7 & AT Next R¥ U Z ML FT,

5! Setup - HxD Hex Editor = ped
Pick Installation Mode "
Do you prefer integration into Windows or a portable installation? I'w
Choose a normal installation that integrates into Windows (e.g., Startmenu, optional
Explorer context menu), or a portable installation that can run on any compatible
Windows machine.
® i‘lorma\ - Integrates into WmduwsE
() Portable - Supports removeable drives (e.g., USB pen drives)
< Back : | Cancel
N N
Next ;j<& /%ﬁbi 3 o
§5 Setup - HxD Hex Editor - X
Select Destination Location =
Where should HxD Hex Editor be installed? I'M_u

Setup will install HxD Hex Editor into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

Browse...

At least 1,2 MB of free disk space is required.

< Back

Cancel

A VAN NVIGET R L C Next RZ V2L ET,

12



ﬁ%’ Setup - HxD Hex Editor = X
Select Additional Tasks
Which additional tasks should be performed? Xy

Select the additional tasks you would like Setup to perform while instaling HxD Hex
Editor, then didk Next.

Additional shortcuts

Create a Quick Launch shortcut

< Badk Cancel
Next RZ &L ET,
ﬁ Setup - HxD Hex Editor - b
Ready to Install
Setup is now ready to begin installing HxD Hex Editor on your computer. N..

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:¥Program Files¥HxD

Additional tasks:
Additional shorteuts:
Create a Quick Launch shortcut

< Back Cancel
A VAP ERZMER LT Install RZ &2 LET,

[ {8 Setup- HaD Hex Editor =

Completing the HxD Hex Editor
Setup Wizard

Setup has finished installing HxD Hex Editer on your computer,
The application may be launched by selecting the installed
shorteuts,

Click Finish to exit Setup.

Launch HxD Hex Editor

DLETCA VA =AM T LET,

13



NAF V2T ¢ HxD ZEEH L F7,

%9 HxD - o X
File Edit Se View Analysis Tools Window Help
DRk B @i 16
Special editors x
e
o =
e e
s =
S =
e —
Uiaciz n
St =
= —
AT =
o e
'UTF-8 Codepoint Invalid
e .
Double (float64) Invalid
S T
Thome i
Do s
e e
DR 7
time_t (32 bit) Invalid
e a4k —
b )
T
Divsoriiy (90%) ot
Disassembly (x86-64) Invalid
e
@ Little endian. ‘OBigendian.
] Show integers in hexadecimal base

e B T,

File A == —® Open 75 FjE CTHRIFE L7z Setup. ffs ZFtr AR FE T,

o0 B x
© v 4 [} PC » O—#N 7127 (C) » LetsNoteBios v | @ | LetsNoteBiosD B F)
[ F e =~ m @

|| Ei A g L=l EH A

[} w7z an [ Setupsts 2018/11/1611:11  FFS 77 4B2KEB|
W pC D SX2BIOS_ORG.rom 2018/11/13 14:33 ROM 77 ) 5832KB

B pATTzI
¥ Hvo—k

B FAshyT
FFaAvh
[ShCead

B A

b 32—z

L, Ok FAS
= MyBoak (E})
= SanDisk128GB

— MvBook (E:} ¥

TN AN: |Selup.ﬂs v ‘ Al files () v

ZIZTIXIC RTA4 7 HE FD LetsNoteBIOS IZ4R:4E L 7= Setup. ffs Z i

14



1% H<D- [CHLtsNoteBios¥Setup s]
@ File Bdit Search View Analysis Tools Window Help

Y@<~/ 8P 2~[F216 [ Windows (aNS) 0] hex
) Sewpis

SEx

Offsec(n) 00 01 62 63 04 05 06 07 08 08 A OB OC OD OF OF Decoded text

00000000 b7 §.mspocs ya2e!
00000020 28 7500

1010111
a1

.Qaf
00000020 2D -m. Nt SeSx0Z. ¥y
00000030 A4 EoY:3 A 215,
00000040 00 2007
2007
-1986787369.
2308179927
4888826714019596247
4888826714019596247
AnsiChar / char8 x
‘WideChar / charl6_t B
UTF-8 Codepoint 15t continuation byte invalid
Single (0at32) -3.66370765247954E-33
Double (A0at64) 7.09091118077807E18
OLETIME Invalid
FILETIME Invalid
DOS date Invalid
DOS time Invalid
DOS time & date Invalid
time_¢ (32bit) Invalid
time_t (64 bit) Invalid
GuD (899407D7-99FE-43D8.9A21.7
Disassembly (x86-16) dath
dath
Disassembly (x86.64) dath
n OBig endian

00000220 74
00000230 A0

(Offset(n):0 Overurite

FLARIA A TIRAE T,

[JShow integers in hexadecimal base.

Search A ==2—® Find %7 U v 2 LT, Hex-values 7*% [0100010100010101] DOfrEZHEL £,

Find x

Text-string  Hexvalues  Integer number Floating poi

Search for: |[}10[}[}1[}1[}[}[}101[}1 o

Search directio
® All

() Forward

() Backward

OK Search all Cancel

1% HaD - [C¥LetsNoteBios¥Setup.is]

s
@ File Biit Soarch View Aualysis Tools Window Help _ex
TR0 S £ 16 [v]| Windows (ANST)
@ Seupts x
oftaecm o0 01 Decoded text
0000F820 58 XA?Zie.". . JRLC
SoooEass) 2 e o0
ooooreso Aa A2 S0
0000F850 01 L]
0000F860 00 1
ao0ore70 o1 i
a000Fes0 00 00 Iz 16842753
oo0oFeso o1 00 Ulnizz 16842753
IR a4, b Int64. 72340168543109121
Cosoesmojiat o Ulnisa 72340168543100121
EONGESHl oo AnsiChar / chas ¢ :
Suorsng; oL WideChar / chacl ¢ :
oo0oFeFo o1 00 UTF8 Codepoint 10001
00007300 00 00 Single (Toats2) 2369056081 13587E-38
oo00Es10 o1 o Dol Loatss) 7748507202130135:304
osocs20 o oEmE 1699/12/30
0000F930 01 FILETIME 1830/03/29 1:07:34
D0S date wlid
D0 time 000
DO time & date 1980/08/01 0,002
tme < (32bi) 1970/07/14 223233
tme+ 64bi) malid
U Talid
add
Disassembly 6:86.32 addfsasjane
Disassembly 686,60 addrmajsnx
0000FA20 Bytn cmder.
0000FA30 (@ Little endian (OBig endian
os00rato
0000FASO | (JShow integers in hexadecimal base
(Ot P44 Block(o; FOMFOB Ovorurie

F3 X —ZM L THICITENC C 2R L TBXEL LY,

Z OFIRE A% 10101010101010101 ) ICEE L ET,

ZORBETEIE &2 427 Y v 7 LT [Paste Write] § 270, EHEERE LTI EIN,
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P e ——— ~ o x
8 Pl B Search View Ansiss Tols Window T Sex
Jvfd| B B 2~ 416 [ Windows@NS) [ hex [

) Sewpfis ‘Special editors x
ortsec ) a0 [E=——

Jr— oo

Goocreso 5 -

0000F850 01 L]

0000F860 00 12014

Gosorsro o 12014

Goorsto 05 1somsssns

Gooorseo 0 s

RUSSNRRS  00: Int 4672870900358450118
bt v fhon Ulntba 4672870900358459118
smgRe o AnsiChar/ chat 5 i

0ooaFsno) for WideChar /a6t &

e UTF 5 Codsoint Lo conimation e el
Gooarsan 00 Singe (Tos2) TosissoTTsITasrEzs
Gooarsto o1 Doutl (lostd) asopLa03TTS6458
aosorsz0 00 e tonyoertrrinas
Goooress o s

goosrss oo DoSdate ao03/07/14

0000F9€0 00 DSt 528,

0000F570 01 DOS time & date.

Gosoreto o1 e G2 2030/02/21 200258
Gosorses o1 imec (G450 ol

Gosoreao o1 o (7120288 75.4000-AB3D-
oosorszo o1 Disssomby (8516 oudnal

0000FSCO 01 Disassembly (x86-32) outdxal

SUMEE, a1, Disassembly (x86-64) out dxal

Goooraco 01

Gooorato o1

0000FA20 01 Byt order

(0000FA30 01 @ Little endian (OBig endian

Gooorago o1

s ] | [EE———
osetrroic BT

ZHELU-HiE T,
EHENELGEWR T L, File A==2—5 [Save] BN LT EEX LET,
U ETOWME 7 7 A VHNDORE LA =2 —DFRT 77 H2EE L TURGFEOEEITKR T T,

LB, T2 THEFHNOFERITKOEY TT,

: {
Copu! igh

\\i\\‘\\‘\\l‘\\

154 (0100010100010101)

73w 27 (0100010100010101) & & LTV V7=
A4 > (0100010100010101)

441 0100010 100010101)

F v 7t vk (0100010100/010101) fE S LTV =
#28h (010001010001j0101)

€% = U7 ¢ (0100010100010 1]01)

%7 (0100010100010101)

16



4, BA A— T 7 A LD SetupPart &2 E Ay ClE#a L CHIL TR

WITEA A= 7 7 A4 )LD Setup #43% [UEFITool | %o TR CRAIFE L7z Setup. ffs TEHLL T

RIFLET,

Aooa—RE P RLICTZEALET,

https://forums. tweaktown. com/gigabyte/30530-1atest—overclocking—programs—system—info-bench

marking—stability—tools—print. html

& 5| ) Latest Overdocking Pro X | =

> O @ | A htps 3

=

z3-2 [ 707 [ Google

f " TweakTown

°* — F ORUMS —

Yohoo! [1] vavEvy [ mHE

printable

< vage Lot 200 Bl 211 51 1ot Tiastm

programs-system-nfo- g

Latest Overclocking Programs, System Info, Benchmarking, & Stability Tools
ble View

‘Show 40 post(s) from this thread on one page

stasio
Latest Overclocking Programs, System Info, Benchmarking, & Stabilty Tools

Stability Test

Prime9sv.29.4 Build 7 (32-bit)
Prime95v.29.4 Build 8 (64-bit)
X264 HD Benchmark 5.01

CCT 4.5.1
IntelBurnTest v2.54-10.3.12 (original)
IntelBurnTest v2.54-11.0.0
IntelBurnTest v2.54-11.0.1

LinX 0.6.5-11.1.0
LinX 0.6.5-11.1.1
LinX 0.6.511.1.2
LinX 0.6.511.1.3
LinX 0.6.5-11.2.0
LinX 0.6.511.2.1

LinX 0.6.8-11.33

LinX 0.6.9-2017.0

LinX 0.7.0-2017.1

LinX 0.9.3

5P2004 Orthos

System stabilty Tester 1.51 (32-bit)

System stabilty Tester 1.51 (64-bit)
FT23.1

HeavyLoad 3.3.1 (32-bit)

HeavyLoad 3.3.1 (64-bit)

Intel@® Linpack 11.1.0.002

Intel@ Linpack 11.1.1.003

Intel@® Linpack 11.1.2.004

Intel@® Linpack 11.1.3.005

Intel@ Linpack 11.2.0.003

//forums tweaktown.com/gigabyte/3

Joy

Google [ Yahoo! [l vavevy [1 mmim

AWARD BIOS Tools
AMI (UEFT) BIOS Tools

AMIBCP 4.55.0070
AMIBCP 5.01.0014

AMIBCP 5.02.0023

MMTool Aptio 4.50.0023
MMTool Aptio 5.00.0007
MMTool Aptio 5.02.0024
MMTool Aptio 5.02.0024 Mod
UEFI BIOS Updater v1.6x.x

FLASHEFI (P67/268)
UEFT back to AWARD
GB EfiFlash 0.52
Efifash 0.62-mod
Efiflash 0.65-mod
Efiflash downgrade
Phoenix Mod Tool 2.19 (SLIC)
Phoenix Mod Tool 2.66 (SLIC)
SLIC Tookit v.3.2
AMI Change Logo 4.55
AMI Change Logo 5.00
FPT_DOS- 277/X79
PT_DOS- 267
FPT-Win64- 287
FPT-Win32/64- 207
FPT-Win32/64- X99
FPT-D0S- 2170
FPT-Win32/64- 2170
FPT-Win32/64- 2170/270
Intel® System Tools v.8.1 (for Intel@® 7)
Intel@® System Tools v.9.0 (for Intel@® 8)
Intel@® System Tools v.9.1 (for Intel@® 9)
Intel® System Tools v.1L.x (for Intel@® 100/200/300)
FTK- Flash ToolKit v0.11 (for Intel® 6/7)
FTK- Flash Toolkit v0.10 (for Intel® 8)
FD44Edor 0.9.1
287 B10S Backup

useful Tools

WInRAR 5.60 Beta 3

UBCDA4Win 3.60

0-latest

overclockin

programs:-system-info-benchmarking-stability-tools-pr

02-20-2009

Here are some of the most popular benchmark softwares used to gauge computer performance. This site and its author wont be held responsible or iable for any lost or damages
resulting from the use of any programs included on this page. The use of any programs included on this page s at your own risks!

] Latest Overclocking Pro. X

I A7 m— LT

[UEF1Tool_0.22.4] %7
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O Retases Longsofyuns X

£ 5 O @ | @ Gtunic s rpsgtubcomongsolyUEFTos!relases

e 0223 0707 [ Gy [ w1 smivr [ Bm

s Bplore Marketplace  Pricing Signin - Sign up

O us | ks 1o | $ron | 2m
e 0 o
Be notified of new releases e
tvare thon dersiopers.
120181114
T viS636 ks s oy g0
v Assets 1
ata
e
e

+ Fixed offset updates at image replacement (4137)

o AGY
- £ its696 reessed this on o 14

~ Assets 1«

e

e

uern a1

sk 2

[UEFITool_0.25.1_win32.zip] #27 U v 27 LCH v ra—RLET,
7 7 A NV40% TUEFITool 0. 25. 1_win32. zip) T3
INEEMHY —NVELIFZZ 7 AT 0= —TEH LTI EE,

FATZ 7 A MiE, TUEFITool. exe] T,

T 77 ANEL TN 7 LTREIILEL X 9,

{} UEFITool 0.25.1 - a X
Fle Action Help

Structure Information

Name Action Type

< >

Messages

18



File A == —® [Open Image File]

R

MNHBLBIOS A A—

{0} Open BIOS image file
€ > v
HE v FLWIANS-

B L} #H

BTN

| ] SX2BIOS_ORG.rom
I rC
W EDATV=IR
I sovo—g
e
TaAvh
B erFr
B vF
D za—vus
i A=A T42S
= My Book (E)}
= SanDisk128GB

— MvBook (E} ¥

s PC » O—71)b FAZ (C) » LetsNoteBios

v 0| | LetsNoteBiosmi »

HFHE wH HAA

2018/11/13 1433 ROM 271 5.632KB

F7AIA&(N): | $X2BIOS ORG.rom

v‘ BIOS image files (*.rom *.bin *.c »

)] Fotill
{} UEFITool 0.25.1 - SK2BIOS_ORG.rom o X
File Action Help
Structure Information
Name Action Type
> UEFT image Image
< >
Messages
parseFile: invalld data checksum 5Ah, should be AAh

Opened: SX2BI0S_ORG.rom

WIZ File A==2—® [Serch]|

ZEENGIRLE T,

{:} Search

Hex pattern

? it
GUID Text
GLID: |8994'3?D‘?-99FE—43DS—9A21—?9EC328CAC21

Search scope

(® Header and body

() Header only

() Body only

| Cancel

19
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Z®IL T, GUID # 7T [899407D7-99FE-43D8-9A21-7T9EC328CAC21 |



File Action Help
Structure

{:} UEFITool 0.25.1 - SX2BIOS_ORG.rom

Name
» UEFI image

Action

Message S/ ICHRBRERNE RSN ET,

ZDOAytE—@ [GUID Pattern...]

DATERZ TN Y v 7 LET,

£} UEFITool 0.25.1 - SX2BI0S_ORG.rom

File Action Help
Stucture

Information

o

x

Name Action
> 996AA1E0-1EBC-4F36-B51..
> BDB712E8-87F5-4BO1-BE4.
> 924A1£90-4609-4D7A-ACF...
> AFS52C372-FFGB-4B49-876..
> FB2E6264-FDCA-4BSD-BEL..
> 4OE7ADGA-ABEC-4AOB-ABE...
> 2068D2C3-ES9B-4D45-A12..
5 24311CAS-32C4-4304-5A0..
> BFE205C9-5B17-4F8F-937..
> 898407D7-99FE -43D8-9A2...
> 7BB28B99-5188- 11D5-945...
> 13F724D3-6DBC-42FB-OFE...
> 243DDBOE-3FR2-4EFE-EDA..
> FFB2BA7C-B8EF-4C36-97...
> 8310F3E3-D300-4561-955...
> A353CD3F-ACAA-4186-B95...
5 7CABGF12-0168-4DDC-AET...
> GEDA271E-7D4D-4138-B97...
> CDB4562C-5854-40A3-A05...

Volume free space

<

Type
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
Free space

a| [Full size: sseesen

(5767168)

Messages

parseFile: invalid data checksum SAh, should be AAh

GUID pattern "53948707-99FE-43D8-0421-79EC32BCAC21" found as "D70794B9FEOSD8430A2179ECI2BCAC21" in 899487D7-09F

T TEIREIN TS GUID 899407D7-99FE-43D8-9A21-79EC328CAC21 |
[Replace as is ...] ZEINL CEBT DT 7 A NV EFAIARLET,

{# Select FFS file to replace selected object
4 [1>PC > B—#A742I(C) » LetsNoteBios
B3 v FLNTAINS-
Eifk A &
BT 1) Senuptts

L, B F1RD
= My Book (E
= SenDisk128GB

= MvBook (E) ¥

HEDN

2018/11/1611:22  FFS 771M

.t

TR |

| [Frs files (~ffs bin)

Fovkll

Z 2 CIIRTE TIRE LT [Setup. ffs] ZFEELET.

20
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{i} UEFITool 0.25.1 - SX2BI0S_ORG.rom - 0 X
File Action Help

Structure Information
Name action Type A| |File cuID:
> 996AA1EG- 1EBC-4F36-B51... File BIMATD7 2IEHI00, A21
> 8DB712E8-B7FE-4B91-BE8.. File };2:3;’5’““
» 924A1E90-4509-4D7A-ACF.. File ALicibures agn
> AF520972-FF6B-4B49-876.. File FUll size: 19B61h
> FB2E6264- FDCA-4B9D-BE File (105313)
» 49ETADGA-4BEC-4ARE-ABH File Header size: 18h (24)
> 2068D2C8-E996-4D45-A12.. File Body size: 19B48h
> 24311CA9-32C4-4804-BAB... File ;igii‘sggsn
» BFE205C9-5817-4F8F-937.. File L
> 89948707-99FE-43D8-9A2.. Remove File ey P
> 89948707-99FE-4308-9A2.. Replace File
» 7BB28BI9-61B6-11D5- A File
5 13F724D3-60BC-42F6-9FE.. File
» 243DDBYE-3FB2-4EFE-BDG.. File
> FF82BA7C-BBBF-4C36-97I File
> B310F3E3-D300-4561-95 File
» A353CD3F-4CAA-4186-B35.. File
» TCABBF12-916B8-4DDC-AET.. File
> GEDA271E-7DAD-4136-B97.. File
> CDB4562C-6864-40A3-ABE.. File v
< >
Messages
parseFile: invalid data checksum SAh, should be AAh
GUID pattern “8994670D7-99FE-4308-9A21-79EC328CAC21" found as "D7679489FESIDB439A2179ECIZBCAC21" in B99487D7-99FF
< >

Z D& DIZIHERSTIZ TRemove] | k7T TReplace] & FRIZZeUIX OK T9,

2 File A ==2—® [Save Image File] #EIR LT, 77 A NLEEZTHREFELET,

Z ZClE. TSX2BIOS_NEW. rom] & UL TIRTELET,

£} Save BIOS image file X

4[> PC > O=ALF{AZ(C) » LetsNoteBios v & | LetsNoteB

EZ v FLWIANT-
- Bt ol 1 i ER e $1L
_J 3DAST I D SX2BIOS_ORG.rom 2018/11/1314:33 ROM 77k 5.832KB

& #o—k

W TRz

FEaAvh

B esFr

g/ vt

I
2, O—=H F4AS
= MyBook (E)
wa SanDisk128GB

= MyBook (E}  «
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